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About Sybase® Control Center for Sybase 1Q

About Sybase® Control Center for Sybase 1Q

Sybase Control Center for Sybase 1Q is a Web-based tool for monitoring the availability and
performance of Sybase 1Q servers.

Sybase Control Center supports Sybase 1Q version 15.1 ESD2.1 and later versions in single-
node and multiplex configurations.

The Sybase Control Center client/server architecture allows multiple clients to monitor all
Sybase 1Q servers in an enterprise using a small number of Sybase Control Center servers.
Sybase Control Center for Sybase 1Q provides availability monitoring, historical monitoring,
and real-time monitoring in a scalable Web application that is integrated with management
modules for other Sybase products. It offers shared, consolidated management of
heterogenous resources from any location, real-time notification of availability and
performance, and intelligent tools for spotting performance and usage trends, all via a thin-
client, rich Internet application delivered through your Web browser.
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Configure

Configure Sybase Control Center for Sybase 1Q.

1. Registering a Sybase 1Q Server

Make Sybase Control Center aware of a Sybase 1Q resource (for example, a server that can
be monitored) and its connection information by registering the resource.

2. Importing Resources
Import and register multiple servers from an interfaces or sgl.ini file.
3. Creating a Perspective
Create a perspective in which you can add and manage resources.
4. Adding a Resource to a Perspective
Add a resource to the current perspective.
5. Authenticating a Login Account for a Monitored Resource

Specify the login account Sybase Control Center will use when it connects to your server
or other resource to collect monitoring data.

6. Setting Up Statistics Collection

Use the Properties view of your managed resource to create a data collection job and add a
schedule to the job.

7. Changing Update Frequency for Statistics and Charts

The frequency with which statistics are collected can give you a general or more specific
view of server performance.

8. Creating an Alert
Use the Add Alert wizard to create an alert instance for your resource.
9. Optional Configuration Steps

Perform additional configuration, including user authorization, alerts, data collection
scheduling, backups, and setting purging options for the repository.

See also

e Setting Up Security

e Logins, Roles, and Groups

» Assigning a Role to a Login or a Group
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Registering a Sybase IQ Server

Make Sybase Control Center aware of a Sybase 1Q resource (for example, a server that can be
monitored) and its connection information by registering the resource.

1. Inthe Resource Explorer, select Resources > Register.

2. Specify:
Table 1. New resource type details
Field Description
Resource Name (Required) Name of the resource to register. Enter the actual
name of the server, including uppercase and lowercase letters. If
the name registered in Sybase Control Center does not exactly
match the server name, some monitoring functions may not work.
Resource Type 1Q Server (15.1.0.0) — monitor Sybase 1Q server.
Description A brief description to help you identify the resource.
3. Click Next.

4. Specify the connection information for your resource:

Table 2. New resource connection details

Field Description
Host Name Host name of the Sybase 1Q server
Port Number Local host port number

5. Click Finish.

See also

» Importing Resources on page 5

»  Error Message is Displayed When Trying to Authenticate a Multiplex Serveron page
51

e Common Display Options
» Importing Resources on page 5
* Resources
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Importing Resources

Import and register multiple servers fromani nt er f aces orsql . i ni file.

Prerequisites
Copythei nt erfacesorsqgl . ini filetoalocationon oraccessible from the machine that
hosts your web browser.

Aninterfaces (UNIX)orsql .ini file (Windows) is a list of Sybase servers and their
ports; it may contain other connection information as well. The file is created during the
installation of a Sybase server:

e Windows: “SYBASE% i ni \ sql . i ni
* Unix: $SYBASE/ i nt er f aces

For more information on i nt er f aces files, see the appendix on configuration files in
Configuration Guide Open Client and Open Server 15.0 for UNIX.

For more information on sql . i ni files, see the chapter on network communications using
sgl.ini in the Adaptive Server Enterprise 15.0 Configuration Guide for Windows.

Note: The Import Resources wizard imports servers in batches of a single type (Adaptive
Server, Sybase 1Q, or Replication Server, for example). If youri nt er f aces orsql . i ni
file includes resources of more than one type, you must perform this procedure for each
resource type.

1. In the application menu, select View > Open > Resource Explorer.

2. Inthe Resource Explorer, select Resources > Import.
The Import Resources wizard opens; I nterfacesfileis already selected.

3. Click Next.
The Directory Service Connection page appears.

4. Click Browse and navigate to the interfaces file you want to import from.
You cannot type in the File name field.
5. Click Next.
6. On the Import Resource Type page, select the type of server you want to import.
7. On the Resource Selection page, click to select the servers you want to import.

Select only servers of the type you chose on the Import Resource Type page. If you import
servers with incorrect types, Sybase Control Center will not be able to monitor or manage
them properly.

Sybase Control Center for Sybase 1Q 5
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8. Resources of your chosen type may require connection parameters in addition to those
present in the file—RSSD host name and port for Replication Server, for example, or
character set and language for Adaptive Server. Enter any required connection parameters.

9. Click Next.
The Confirmation page displays a list of the resources you have selected.

10. Click Finish if you are ready to import, or click Back to return to the previous screen and
change your selections.
When you click Finish, Sybase Control Center imports and registers the resources and
displays a summary page.

11. Click Close to finish the wizard.
The newly imported resources appear in the Resource Explorer.

Next
Add the new resources to a perspective so you can monitor and manage them.

See also

» Registering a Sybase 1Q Serveron page 4
e Creating a Perspective on page 6

» Registering a Sybase 1Q Serveron page 4
* Resources

Creating a Perspective

Create a perspective in which you can add and manage resources.

1. From the application menu bar, select Perspective > Create.
2. Enter a name for your perspective. The name can contain up to 255 characters.
3. Click OK.

See also

» Importing Resources on page 5

» Adding a Resource to a Perspective on page 6
*  Perspectives

Adding a Resource to a Perspective

Add a resource to the current perspective.

Add a server or other resource to a perspective so you can monitor and manage it along with
other resources in the same perspective.

6 Sybase Control Center
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1. From the Sybase Control Center toolbar, click the Launch resource explorer icon.

2. Select the resources to add to your perspective. Select multiple resources by pressing the
Ctrl key while you select. Then perform one of these actions:

* Select Resources > Add Resourcesto Perspective.

« Drag and drop resources from the Resource Explorer onto the Perspective Resources
view. You can select and drag multiple resources.

See also
e Creating a Perspective on page 6
* Authenticating a Login Account for a Monitored Resource on page 7

Authenticating a Login Account for a Monitored Resource

Specify the login account Sybase Control Center will use when it connects to your server or
other resource to collect monitoring data.

Perform this task for each resource registered with Sybase Control Center.

Note: You can also authenticate a server when you create a collection job.

1. Connect a browser to Sybase Control Center and log in.

2. In the Perspective Resources view, right-click the icon for your resource and select
Authenticate.

3. Select Use my current SCC login or Specify different credentials.

4. If you chose Specify different credentials, enter the login and password for Sybase
Control Center to use to connect to your resource.

5. Ifthe selected server is a Replication Server, also enter the RSSD user name and password.
6. Click OK to exit the dialog.

See also
» Adding a Resource to a Perspective on page 6
» Setting Up Statistics Collection on page 8

e Error Message is Displayed When Trying to Authenticate a Multiplex Serveron page
51

e Setting Up Security
o User Authorization
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Setting Up Statistics Collection

Use the Properties view of your managed resource to create a data collection job and add a
schedule to the job.

For best performance, Sybase recommends these guidelines for scheduling data collection
jobs:

1

Schedule only one collection job for each collection.
Set the collection interval to 60 seconds or more.

In the Perspective Resources view, select a resource and select Resource > Properties.

Select Collection Jobs.

Click Create Job.
The Create Collection Job window opens.

If this resource has not been authenticated yet, the Authentication page appears. Enter a
user name and password that Sybase Control Center can use to log in to the resource. Then
click Authenticate to allow Sybase Control Center to verify your credentials.

Select the data collection that this job will run and click Next.

(Optional) If you do not want to create a schedule yet, click to uncheck Createaschedule
for thisjob.

Specify details for the new schedule:

Table 3. New schedule details

Field Description

Name A name for this schedule

Description A description of the schedule

Start date The day when the schedule will take effect
Time The time when the schedule will take effect

Note: Enter dates and times using the server’s local time.
Choose an option to specify the duration of this schedule:

* Runonce
* Repeat until
For Repeat until, specify these details:

Sybase Control Center
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Field Description

Repeat interval Interval, in seconds, between recurrences to be added to the
schedule

Repeat until End date

Time Time when the job is to end

* Repeat indefinitely
For Repeat indefinitely, specify these details:

Field Description
Repeat interval Interval, in seconds, between recurrences to be added to the
schedule
9. Click Finish.
See also

o Authenticating a Login Account for a Monitored Resource on page 7
e Changing Update Frequency for Statistics and Charts on page 17

»  Graphing Performance Counters on page 28

e Job Scheduling

About Statistics
Understand availability and performance statistics in Sybase Control Center.

The statistics you work with in Sybase Control Center can be divided into two types:

« Availability statistics are concerned with present conditions; they help you determine
whether a resource you are monitoring (a server or an agent, for example) is running and
functioning properly.

» Performance statistics are concerned with behavior of the same resources over time. They
describe the flow of data through your environment. You can use performance statistics to
spot trends, identify problems like resource bottlenecks, and make plans.

Sybase Control Center includes predefined key performance indicators (KPIs) for each
product module; these KPIs are grouped into collections. KPIs such as server status, which
serves as an availability statistic when it is fresh, have long-term value as historical
performance statistics.

Auvailability statistics appear on the heat chart and on resource monitoring screens in each
product module.

Performance statistics appear on the statistics chart and on resource monitoring screens in
each product module.

Some KPIsare included in the default collection for each product module. To make other KPIs
available to the heat chart, statistics chart, and resource monitoring views, you must set up

Sybase Control Center for Sybase 1Q 9
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collection jobs in the scheduler. See the data collections help topic for your Sybase Control
Center product module for information on data collections and the KPIs contained in them.

Several configuration options affect the collection and display of data in Sybase Control

Center:

« Collection repeat interval—The frequency of data collection. Set this on the collection job

in the scheduler.

» Screen refresh interval—The period between screen refreshes. Refreshing the screen
redraws it with the newest available data. Set the screen refresh interval in the product
module. (May not be settable in all product modules.)

» Chart trend period—The period over which data is displayed in historical charts. Set the
trend period in the product module. (May not be settable in all product modules.)

Sybase IQ Data Collections

Lists and describes predefined data collections you can use to create jobs for Sybase 1Q.

Table 4. Data collections for Sybase IQ

Collection Description

All statistics collection Contains all statistics, including server availability and
performance statistics.

Availability statistics collection Contains server availability statistics used in the heat
chart.

This is the default collection, and is automatically cre-
ated at login. By default, the statistics are collected every
60 seconds.

Engine statistics collection Contains performance statistics and includes the follow-
ing KPIs:

1Q maximum memory allocated
1Q memory allocated

1Q server system CPU usage

1Q server total CPU usage

1Q server user CPU usage

1Q threads available

1Q threads in use

10
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Collection Description
Connection statistics collection Contains performance statistics and includes the follow-
ing KPIs:

¢ Number of active connections

«  Number of active INC incoming connections
«  Number of active INC outgoing connections
¢ Number of active user connections

«  Number of connections available

«  Number of user connections per minute

«  Number of user disconnections per minute

Transaction statistics collection Contains performance statistics and includes the follow-
ing KPIs:

e Number of active INC transactions

*  Number of active load table statements
*  Number of active transactions

*  Number of active user transactions

DBSpace statistics collection Contains dynamic statistics for each dbspace, including:

e dbspace size in use
e percentage of available dbspace

DBSpace file statistics collection Contains dynamic statistics for each dbspace file, in-
cluding:

e dbspace file size in use
« percentage of available dbspace File

Store 1/0 statistics collection Contains performance statistics and includes the follow-
ing KPIs:

« Catalog store disk reads
« Catalog store disk writes
e Main store disk reads

*  Main store disk writes

e Temp store disk reads

e Temp store disk writes

Sybase Control Center for Sybase 1Q 11



Configure

Collection

Description

Caches statistics collection

Contains performance statistics and includes the follow-
ing KPIs:

Catalog cache hits

Catalog cache reads

Catalog cache size

Catalog cache in use percent
Catalog cache pinned

Catalog cache pinned percent
Catalog cache dirty pages percent
Temp cache hits

Temp cache reads

Temp cache size

Temp cache in use percent
Temp cache pinned

Temp cache pinned percent
Temp cache dirty pages percent
Main cache hits

Main cache reads

Main cache size

Main cache in use percent
Main cache pinned

Main cache pinned percent
Main cache dirty pages percent

Op/Req statistics collection

Contains performance statistics and includes the follow-
ing KPIs:

1Q active operations
1Q waiting operations
Requests per second
Unscheduled requests

12
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Collection

Description

Network statistics collection

Contains performance statistics and includes the follow-
ing KPIs:

e Available communication buffers
e Bytes received

e Bytes received uncompressed

e Bytes sent

e Bytes sent uncompressed

e Total communication buffers

See also

e Creating an Alerton page 18

Key Performance Indicators for Sybase 1Q

Lists and describes the key performance indicators (KPIs) that provide the statistics displayed
on Sybase 1Q screens and charts in Sybase Control Center.

Each Sybase 1Q data collection includes a subset of the KPlIs listed here.

KPI

Description

Active INC incoming connec-
tions

Number of internode communication (INC) incoming connections.

Active INC outgoing connec-
tions

Number of INC outgoing connections.

Active INC transactions

Number of active INC transactions.

Active load table statements

Number of active load table statements.

Active transactions

Total number of active transactions including user and INC trans-
actions.

Active user connections

Number of active user connections.

Active user transactions

Number of active user transactions.

Available communication buf-
fers

Number of available network communication buffers.

Bytes received

Number of bytes per second received during client/server commu-
nications.

Sybase Control Center for Sybase 1Q

13



Configure

KPI

Description

Bytes received uncompressed

Number of bytes per second that would have been received during
client/server communications if compression was disabled.

Bytes sent

Number of bytes per second sent during client/server communica-
tions.

Bytes sent uncompressed

Number of bytes per second that would have been sent during
client/server communications if compression was disabled.

Catalog cache dirty pages per-
cent

Percentage of pages in the catalog cache where data has been
modified and stored in the buffer cache and has not yet been written
to disk.

Catalog cache hits

Number of catalog cache hits per second.

Catalog cache size

Current catalog cache size in megabytes.

Catalog cache in use percent

Percentage of the catalog cache in use.

Catalog cache pinned

Number of pinned catalog cache pages.

Catalog cache pinned percent

Percentage of the catalog cache pinned.

Catalog cache reads

Number of catalog cache page lookups per second.

Catalog store disk reads

Number of kilobytes per second that have been read from the cat-
alog store.

Catalog store disk writes

Number of kilobytes per second that have been written to the cat-
alog store.

CPU total usage

Percentage of the Sybase 1Q server CPU in use, including both
system and user usage.

CPU system usage

Percentage of the CPU being used by the system.

CPU user usage

Percentage of the CPU being used by the users.

Dbspace size in use

Amount of space being used in the dbspace, in kilobytes.

Dbspace space available per-
cent

Percentage of dbspace available.

Dbspace file size in use

Amount of space being used in the dbspace file, in kilobytes.

Dbspace file space available
percent

Percentage of the dbspace file available for use.

1Q active operations

Number of active concurrent operations admitted by Sybase 1Q
resource governor.

14
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KPI

Description

1Q threads in use

Number of threads used by the Sybase 1Q server.

1Q waiting operations

Number of 1Q operations waiting for the resource governor.

Main cache dirty pages percent

Percentage of pages in the main cache where data has been modi-
fied and stored in the buffer cache and has not yet been written to
disk.

Main cache hits

Number of main cache hits per second.

Main cache in use percent

Percentage of the main cache in use.

Main cache pinned

Number of pinned main cache pages.

Main cache pinned percent

Percentage of the main cache pinned.

Main cache reads

Number of main cache page lookups per second.

Main cache size

Current main cache size in megabytes.

Main store disk reads

Number of kilobytes per second that have been read from the main
store.

Main store disk writes

Number of kilobytes per second that have been written to the main
store.

Maximum memory allocated

Maximum memory allocated by the Sybase 1Q server in megabytes.

Memory allocated

Memory allocated by the Sybase 1Q server in megabytes.

Number of active connections

Total number of active connections, including user and internode
communication connections.

Number of connections availa-
ble

Number of concurrent connections available.

Number of 1Q threads available

Number of threads available in the 1Q server.

Requests per second

Number of times per second the server has been accessed to handle
a new request or continue processing an existing request.

Sybase Control Center for Sybase 1Q
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KPI

Description

Server availability

State of the Sybase 1Q server. Valid values are:

«  UNKNOWN(0)
« STOPPED(Y)

«  PENDING(2)

«  RUNNING(3)

«  WARNING(4)
« ERROR(5)

Temp cache dirty pages percent

Percentage of pages in the temporary cache where data has been
modified and stored in the buffer cache and has not yet been written
to disk.

Temp cache hits

Number of temporary cache hits per second.

Temp cache in use percent

Percentage of the temporary cache in use.

Temp cache pinned

Number of pinned temporary cache pages.

Temp cache pinned percent

Percentage of the temporary cache pinned.

Temp cache reads

Number of temporary cache page lookups per second.

Temp cache size

Current temporary cache size in megabytes.

Temp store disk reads

Number of kilobytes per second that have been read from the tem-
porary store.

Temp store disk writes

Number of kilobytes per second that have been written to the tem-
porary store.

Total communication buffers

Total number of network communication buffers.

Unscheduled requests

Number of requests that are currently queued up waiting for an
available server thread.

User connections per minute

Number of user connections per minute.

User disconnections per minute

Number of user disconnections per minute.

See also

e Graphing Performance Counters on page 28
e Creating an Alerton page 18

16
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Changing Update Frequency for Statistics and Charts

The frequency with which statistics are collected can give you a general or more specific view
of server performance.

1. In the Perspective Resources window, right-click the resource and select Monitor
Node.

For a multiplex resource, select Monitor Multiplex.
2. In the left pane of the IQ Node Level Monitor view, select Settings.

3. For Screen Refresh Interval, enter the number of seconds between statistic collections.
You can also use the up and down arrows to select the appropriate number of seconds.

The default is 30 seconds.
4. For Chart Trend Period, enter the number of minutes of data to appear in charts.

The minimum number of minutes is 5, and the maximum number is 999999999. The
default is 30 minutes.

Because data is collected only when a chart view is open, a chart contains data starting
from when you open that chart. Each refresh interval adds new data to the end of the graph.
A chart trend of 30 minutes shows the statistics trend over the last 30 minutes, even if the
view has been open longer than 30 minutes.
5. For multiplex-level monitoring:
a) For Maximum Number of Nodesto Show in Chart, enter the maximum number of
nodes to include in any monitoring charts.
The default is 10 nodes.

b) Click Select Nodes, then choose the nodes to include in the monitoring charts. You
cannot select more than the maximum number of nodes.

c) Click OK.
6. Click Apply.

See also
» Setting Up Statistics Collection on page 8
e Creating an Alert on page 18
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Creating an Alert

Use the Add Alert wizard to create an alert instance for your resource.

Prerequisites

You must have administrative privileges (sccAdminRole) to perform this task.

Specify an e-mail server for Sybase Control Center to use for alerts. If an e-mail server is
not configured, you cannot create alert subscriptions.

Schedule data collections. Alerts for each product module are based on one or more data
collections. If the correct collection or collections are not scheduled to run, the alert system
cannot function and no alerts are generated. See the data collections topic for your product
module for information on which collections you need to schedule to enable alerts.
(Optional) If you want this alert to trigger the execution of a shell script, copy the scriptto a
location on or accessible from the machine that hosts your Sybase Control Center server.

Warning! Use caution in writing scripts. A poorly designed script can cause a blocking
situation, creating a lock-up in your Sybase Control Center server.

Note: Only alerts on Adaptive Server or Replication Server resources can trigger script
execution.

1

In the Perspective Resources view, click the server or other resource and select Resource
> Properties in the view’s menu bar.

Select Alertsin the left pane and click Add.

The Add Alert Wizard opens. If the selected resource supports child alerts, the wizard
opens to the Resource page. If the resource does not support child alerts, the wizard opens
to the Type page.

On the Resource page of the wizard, select the object on which you want to set the alert.
Expand the folder representing the server or agent to select lower-level child objects.

Click Next.
The Type page of the wizard appears.

Select the alert type and click Next.

For this step and the next one, see the topic on key performance indicators for information
on what this alert monitors and how it is triggered. (Each alert is based on a KP1.)

Based on the type of alert you selected, do one of the following:

» For a state-based alert: Select a severity level for each alert state.

Note: You can associate only one severity level with each state.

» For athreshold-based alert: Review and if necessary adjust the range of values that
defines each severity.

18
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7. Click Next.

The Storm Suppression page of the wizard appears.

8. Enter the storm suppression period, which suppresses redundant alerts resulting from the
same condition (an alert storm) for the specified period of time. (The default is 60
seconds.) Enter this value in seconds, minutes, or hours in Storm Suppression Period and
click Next.

9. (Optional; not available for alerts on Sybase 1Q servers) To configure this alert to trigger
the execution of a script:

a) Type Configuration specifies the alert severity level that triggers the script. Select
Critical, Warning, or both.
Critical is more serious than Warning.

b) Enter or browse to the location of the script.

c) Enter parameter values in the Execution Parameter s box.
The string you enter is passed on the command line to the script. You can include a
number of predefined substitution parameters, which are replaced by values from the
alert. See the example (below) and the substitution parameters topic (linked below) for
more information.

d) Click Next.

If the selected resource has sibling resources (databases or devices of the same type, for

example) that support this alert type, the Duplicates page appears. If the selected resource

has no identical siblings, the Subscription page appears.

10. (Optional) On the Duplicates page, select any resources that should use this alert definition
as a template for their own alerts. Click the box at the top of the list to select all the
resources listed. Then click Next.

This step saves time when you need to configure similar alerts for several resources of the
same type.

11. (Optional) On the Subscription page, specify e-mail addresses if you want this alert to
issue e-mail notifications when it fires.

The e-mail addresses default to the address in your user profile, but you can override the
defaults.

For both critical and warning alerts:

Table 5. Alert subscription details

Option Description

E-mail Message To send an e-mail notification when this alert fires, click the E-mail
M essage box and enter the e-mail address of one user or list.

Sybase Control Center for Sybase 1Q 19
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Option Description

Escalation E-mail To escalate this alert (by sending an e-mail notification to another
address when this alert has not been responded to after a specified
period of time), click the Escalation E-mail box and enter the e-mail
address of one user or list. Note that you cannot enter an escalation
address unless you enter an address for primary notification first.

Time Period Enter the amount of time to wait, following the initial alert notification,
before Sybase Control Center sends an e-mail notification to the esca-
lation address.

12. Click Finish.

Example: An alert-triggered script

This sample script is a Windows . bat file:

@cho off

@cho. >> stest.txt

@cho %ate% % i ne% >> stest.txt
@cho arg0: % >> stest.txt
@cho argl: % >> stest.txt
@cho arg2: 9% >> stest.txt
@cho arg3: 98 >> stest.txt
@cho arg4: % >> stest.txt
@cho argh: % >> stest.txt
@cho arg6: % >> stest.txt
@cho arg7: % >> stest.txt
@cho arg8: %8 >> stest.txt
@cho arg9: 99 >> stest.txt
@cho. >> stest.txt

This is a sample execution parameter string for the script above:
Ti me: % me%

Severity: %Beverity%

Resour ce: %Resour ce%

Server: %op_resource%

KPI : %KPI %

State: %Current _state%

URL: %SCC_URL%

The script’s ouput might look like this:

Tue 12/15/2009 14:54: 45. 58

arg0: C:\project\sccnain\script-test. bat
argl: Tinme:"Mn Dec 21 21:30:04 2009"
arg2: Severity: CRI TI CAL

arg3: Resource:"SCC Tester 1"

arg4: Server:"SCC Tester 1"

arg5: KPI: kpi _scc_nostate_primary

arg6: State: ERROR

arg7: HYPERLINK "http://ik-scc.sybase.com 8282/ scc"URL: http://i k-
scc. sybase. com 8282/ scc

ar g8:

ar g9:
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See also
Changing Update Frequency for Statistics and Charts on page 17
Optional Configuration Steps on page 24

Sybase 1Q Data Collections on page 10

Key Performance Indicators for Sybase 1Q on page 13
Assigning a Role to a Login or a Group

Configuring the E-mail Server

Alerts

Sybase IQ Alert Templates

Configure

Lists and describes alert templates you can use to create alert instances for Sybase 1Q.

The alert templates are based on the same key performance indicators (KPIs) that are collected
for the Sybase 1Q node level monitor displays, and for the Statistics Chart.

Alert Template Description Alert
Type
Active INC incoming Number of internode communication (INC) incoming Threshold
connections connections.
Active INC outgoing Number of INC outgoing connections. Threshold
connections
Active INC transactions | Number of active INC transactions. Threshold
Active load table state- Number of active load table statements. Threshold
ments
Active transactions Total number of active transactions, including user and Threshold
INC transactions.
Active user connections | Number of active user connections. Threshold
Active user transactions | Number of active user transactions. Threshold
Available communica- Number of available network communication buffers. Threshold
tion buffers
Bytes received Number of bytes per second received during client/server | Threshold
communications.
Bytes received uncom- Number of bytes per second that would have been received | Threshold
pressed during client/server communications if compression was
disabled.
Bytes sent Number of bytes per second sent during client/server Threshold

communications.

Sybase Control Center for Sybase 1Q
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Alert Template Description Alert
Type
Bytes sent uncompressed | Number of bytes per second that would have been sent | Threshold
during client/server communications if compression was
disabled.
Catalog cache dirty pages | Percentage of pages in the catalog cache where data has | Threshold
percent been modified and stored in the buffer cache and has not
yet been written to disk.
Catalog cache hits Number of catalog cache hits per second. Threshold
Catalog cache in use per- | Percentage of the catalog cache in use. Threshold
cent
Catalog cache pinned Number of pinned catalog cache pages. Threshold
Catalog cache pinned Percentage of the catalog cache pinned. Threshold
percent
Catalog cache reads Number of catalog cache page lookups per second. Threshold
Catalog store disk reads | Number of kilobytes per second that have been read from | Threshold
the catalog store.
Catalog store disk writes | Number of kilobytes per second that have been written to | Threshold
the catalog store.
CPU total usage Percentage of the Sybase 1Q server CPU in use, including | Threshold
both system and user usage.
1Q active operations Number of active concurrent operations admitted by the | Threshold
Sybase 1Q resource governor.
1Q threads in use Number of threads used by the Sybase 1Q server. Threshold
Main cache hits Number of main cache hits per second. Threshold
Main cache in use per- Percentage of the main cache in use. Threshold
cent
Main cache pinned Number of pinned main cache pages. Threshold
Main cache pinned per- | Percentage of the main cache pinned. Threshold
cent
Main cache reads Number of main cache page lookups per second. Threshold
Main cache size Current main cache size in megabytes. Threshold

22
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Alert Template Description Alert
Type
Main store disk reads Number of kilobytes per second that have been read from | Threshold
the main store.
Main store disk writes Number of kilobytes per second that have been written to | Threshold
the main store.
Number of active con- Total number of active connections, including user and | Threshold
nections internode communication connections.
Number of connections | Number of concurrent connections available. Threshold
available
Number of IQ threads Number of threads available in the Sybase 1Q server. Threshold
available
Requests per second Number of times per second the server has been accessed | Threshold
to handle a new request or continue processing an existing
request.
Server availability Status of the Sybase 1Q server. State
Temp cache dirty pages | Percentage of pages in the temporary caches where data | Threshold
percent has been modified and stored in the buffer cache and has
not yet been written to disk.
Temp cache hits Number of temporary cache hits per second. Threshold
Temp cache in use per- | Percentage of the temporary cache in use. Threshold
cent
Temp cache pinned Number of pinned temporary cache pages. Threshold
Temp cache pinned per- | Percentage of the temporary cache pinned. Threshold
cent
Temp cache reads Number of temporary cache page lookups per second. Threshold
Temp cache size Current temporary cache size in megabytes. Threshold
Temp store disk reads Number of kilobytes per second that have been read from | Threshold
the temporary store.
Temp store disk writes Number of kilobytes per second that have been written to | Threshold
the temporary store.
Total communication Total number of network communication buffers. Threshold

buffers

Sybase Control Center for Sybase 1Q
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Alert Template Description Alert
Type

Unscheduled requests Number of requests that are currently queued up waiting | Threshold

for an available server thread.

User connections per mi- | Number of user connections per minute. Threshold

nute

User disconnections per | Number of user disconnections per minute. Threshold

minute

Alert Types and Severities for Sybase 1Q
Learn about the properties that define and control alerts.

An alert’s type determines what causes it to fire.

Table 6. Alert types

Type Description

State A state alert fires when the metric on which it is based changes to a particular state.
The possible states are running, pending, stopped, warning, error, and unknown.

Threshold A threshold alert fires when the metric on which it is based passes a preset level.

Alert severities control when an alert is issued. You can configure the states or threshold values
for each alert.

Table 7. Alert severities

Severity Description
Normal No alert is issued.
Warning A problem has given cause for concern. An alert is issued; you can subscribe to

alerts that fire at the Warning level.

Critical A serious problem exists. An alert is issued; you can subscribe to alerts that fire at

the Critical level.

Optional Configuration Steps

Perform additional configuration, including user authorization, alerts, data collection
scheduling, backups, and setting purging options for the repository.
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Table 8. Configuration areas

Configure

Configuration area |Description Topic

User authorization Set up groups of users or assign roles. User Authorization
Make sure there are users with adminis-
trative privileges (sccAdminRole).

Authentication Add authentication modules to allow Setting Up Security
Windows, UNIX, or LDAP users to log in
to Sybase Control Center.

Alerts Modify alert thresholds and subscriptions | Alerts
and delete alerts.

Data collection Modify collection intervals and sched- Job Scheduling
ules, suspend and resume the schedule,
and delete collection jobs.

Resources Unregister resources, add them to per- Resources
spectives, or remove them.

Perspectives Create, remove, and rename perspectives. | Perspectives

Repository Set purging options and schedule backups | Repository
of the repository database.

See also

e Creating an Alerton page 18

Sybase Control Center for Sybase 1Q
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Manage and Monitor

Sybase Control Center allows you to manage and monitor resource availability status, view
performance statistics, and provides various log information for system administrators to
debug application errors.

Heat Chart

The heat chart displays status and availability statistics for managed resources in the current
perspective.

The heat chart displays the state of resources in your perspective—whether the resources are
running, suspended, or down. In addition, the heat chart lists the type of each resource and
provides statistical data, including the start time of the last data collection.

In the Perspective Heat Chart view, you can filter the resources that you want to see. You can
also search and sort the results by column. From within the Perspective Heat Chart, you can
right-click a resource to see a menu of monitoring and administrative options that vary based
on the resource type.

Heat chart data is collected directly from managed servers, tagged with the date and time when
it was collected, and stored in the Sybase Control Center repository.

Displaying Resource Availability
Use the heat chart to view availability information on the servers in the current perspective.

1. From the application menu bar, select View > Open > Heat Chart.

2. (Optional) Todisplay tools for filtering (narrowing the list of resources in the heat chart) or
changing the columns, select View > Filter from the Perspective Heat Chart menu bar.
The Filter and Column tools appear in the left pane.

3. (Optional) To use filtering, select View > Filter from the view’s menu bar and enter a
search term in the Filter string field.

The search term can be any string that appears in the tabular portion of the heat chart, such
as the name, or part of the name, of a server or a resource type (ASE Server, for example).

4. (Optional) Select a filtering setting:

* Match case - search for resources whose displayed data includes the search term,
including uppercase and lowercase letters; or

* Exact match —search for resources whose displayed data includes an item identical to
the search term.

5. (Optional) Select a column from the Filter on list to restrict your search to that column.
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6. (Optional) Click Columnsto customize your heat chart.
7. (Optional) Unselect any column that should not appear in your heat chart.

8. (Optional) Click the sorting arrow in the column headers to sort the column values in either
ascending or descending order.

9. (Optional) Right-click the resource’s row to view a menu of options for the selected
resource.

10. (Optional) To resize the Filter and Columns tools pane, move your mouse over the border
between the tools pane and the resource table. When the mouse cursor changes to a resize
icon, click and drag the border to the left or the right.

11. (Optional) To hide the Filter and Columns tools, unselect View > Filter.

Historical Performance Monitoring

Monitor performance data to determine whether your environment is working efficiently.

Obtain detailed information about the status of the resources in your environment. You can
create performance graphs that illustrate resource performance over a specified period of
time.

Graphing Performance Counters

Generate a graph for any set of performance counters to show performance trends.

Prerequisites

Verify that statistical data to be graphed has been collected. To verify data collection, go to the
Collection Jobs page of the Resource Properties view and check the History tab for a
collection job. You can also look at the resource monitor: if data is displayed, data is being
collected.

1. In the Perspective Resources view, click a resource and select Resource > Launch
Statistics Chart in the view menu bar.

2. Expand the folders in the Statistics tab and select the key performance indicator (KPI) you
want to graph.

3. Click Graph Statistic or drag the KPI onto the Chart tab.
The Chart tab displays the graphed data, while the KPI with its corresponding value and
the date and time it was collected appear in the Data tab.

4. (Optional) Repeat to add additional KPIs to the graph.

5. (Optional) Use the slider at the bottom of the Chart tab to control the amount of time
covered by the graph, ranging from a minute to a year.

6. (Optional) Use <<, <, >, and >> to move the displayed graph to an earlier or later time,
depending on how the slider is set.
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7. (Optional) You can click the date/time that appear above the slider. Use these to change the
start and end date/time and the chart time span.

8. (Optional) Click Clear Graph to remove all the graphed statistics and start anew.

Note: You can graph a maximum of five statistics with no more than two distinct units of
measure. By default, only 24 hours of statistics are available; change the repository purge
options to save statistics for a longer period.

See also

e Key Performance Indicators for Sybase 1Q on page 13
»  Setting Up Statistics Collection on page 8

»  Configuring Repository Purging

Manage and Monitor Sybase Control Center for Sybase 1Q
Manage and monitor Sybase Control Center for Sybase 1Q through the activity logs.

Viewing the Sybase Control Center for Sybase 1Q Log
View event logs for Sybase Control Center for Sybase 1Q.

Sybase Control Center for Sybase 1Q uses Log4J for message logging. The Sybase Control
Center for Sybase 1Q log files are located at:

e Windows — “SYBASE% SCC- 3_1\ pl ugi ns\ | QVAP\ | og\i grmap. | og
e UNIX-$SYBASE/ pl ugi ns/ | QVAP/ | og/ i gmap. | og

1. Display one of the log files using a log viewer or a method of your choice.
2. Look for entries of interest such as login attempts or the failure of a service to start.

See also
* Logging

Modifying Sybase 1Q Log Configuration

Change the log level or logging configuration settings for Sybase 1Q.

1. Navigate to “USYBASE% SCC- 3_1\ pl ugi ns\ | QVAP.

2. Openthe | QvapLog4j . properti es file, and modify the settings as needed.
3. Save and close the | QvapLog4j . properti es file.

4. Restart the SCC server.

IQMAP messages are recorded in the console and the i qmap. | og file. The i gmap. | og
file is located at 5YBASE% SCC- 3_1\ pl ugi ns\ | QVAP\ | og.
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Monitor the Sybase IQ Environment

Monitor all single-node and multiplex servers in the Sybase 1Q environment.

Monitoring a Single Node
Statistics allow you to monitor the availability and performance of a single Sybase 1Q server.

See also
»  Monitoring a Multiplex Serveron page 41

Viewing Overview Statistics
Display high-level statistics for the selected Sybase 1Q server.

1. In the Perspective Resources window, right-click the resource and select Monitor
Node.

2. In the left pane of the IQ Node Level Monitor view, select Overview.
3. Select the tab for the desired information.

Note: Click a column header to sort the data by that column.

To display the information in a chart or table in the full window, select the Maximize icon in
the top right of the area.

Hover the mouse pointer over any line or bar graph to display information for that graph.
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Tab Description

Server State — current status of the server. Valid states include:
¢ Unknown
« Stopped
¢ Running

Host — host name where the server is running.
Port — port number where the server is running.
Server name — name of the server.

Database — name of the Sybase 1Q database.

Server type - type of server the database is on. Server types include Single Server,
Coordinator, Reader, and Writer.

Server version — version of the Sybase 1Q server.

Platform — operating system running on the server host.

Activities | CPU total usage (%) — total CPU usage percentage, including both system and user
usage.

Active connections— total number of active connections, including user and internode
communication connections.

Connections available — number of connections available for users and internode
communication connections.

Active requests — number of active requests on the server.

1Q threadsin use— number of threads being used by the Sybase 1Q server.
Active transactions— number of active transactions.

Number of committed transactions— number of committed transactions.

Oldest transaction (minutes) — elapsed age, in minutes, of the oldest transaction.

Caches Catalog cachereads(per second) —number of catalog cache page lookups per second.
Main cache size (M B) - size of the main cache, in megabytes.

Temp cache size (MB) - size of the temporary cache, in megabytes.

Remaining heap size (M B) — size of the remaining heap allocation, in megabytes.
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Tab Description

Version us- | Number of committed versions— the number of table versions in the server.
age Total version space used (M B) — total space consumed by all the table versions.
Oldest version I D — the oldest version identifier on the server.

Number of active ver sions— total number of active write table versions on the server.

Total active version space created (M B) — amount of data created by active write
transactions.

Total activeversion spaceto bedestroyed (M B) —amount of data destroyed by active
write transactions. If these transactions commit, the destroyed data becomes an old
version and is eventually dropped. If the transactions roll back, the created data is
released.

Details Server full version — version of the 1Q server software, including the date and time.

Platform version — version of the operating system installed on the server host.

Alerts Any alerts for the selected server. While the montior is open, alerts are displayed as they
are created.

CPU histo- | Percentage of total CPU usage over a period of time.
ry chart

1Q memo- | Allocation of the IQ memory between the main cache, temporary cache, and remaining
ry chart heap.

Disk usage | Available and used space for the main and temporary stores.
chart

See also
*  Viewing Multiplex Overview Statistics on page 42

Viewing All Statistics
Display all the statistics for the selected Sybase 1Q server.

1. In the Perspective Resources window, right-click the resource and select M onitor
Node.

2. In the left pane of the 1Q Node Level Monitor view, select All statistics.
For each group of statistics, expand the heading to list the individual key performance
indicators (KPIs) in that group. The list shows:
» Name of the KPI
e Current value of the KPI
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e Unit of the value
« Description of the KPI

Viewing Engine Statistics
Display the engine statistics for the selected Sybase 1Q server.

1. In the Perspective Resources window, right-click the resource and select Monitor
Node.

2. In the left pane of the IQ Node Level Monitor view, select Engine.

Note: To display the information in a chart or table in the full window, select the Maximize
icon in the top right of the area.

Hover the mouse pointer over any line or bar graph to display information for that graph.

Area Description

Engine statis- | Displays the statistics for the engine. The calculations are continuously updated
tics table based on live server information. The engine statistics include:

CPU total usage — Percentage of CPU total usage.
CPU system usage — Percentage of CPU system usage.
CPU user usage — Percentage of CPU user usage.

Total memory allocated (M B) — Total amount of memory (in megabytes) allocated
for the main cache, temporary cache, and remaining heap.

Max memory allocated (M B) — Maximum amount of memory (in megabytes)
allocated for the main cache, temporary cache, and remaining heap.

Main cache (M B) — Total size of the main cache, in megabytes.
Temp cache (M B) — Total size of the temporary cache, in megabytes.
1Q threadsin use— Number of 1Q threads in use.

1Q threads available — Number of available IQ threads.

1Q memory Shows the allocation of the 1Q memory between the main cache, temporary cache,
chart and remaining heap.

CPU history Displays the percentage of total, system, and user CPU usage over a period of time.
chart
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Viewing Connection Statistics

Display the connection statistics for the selected Sybase 1Q server.

1. In the Perspective Resources window, right-click the resource and select M onitor

Node.

2. In the left pane of the IQ Node Level Monitor view, select Connections.
3. Select the tab for the desired information.

Note: To display the information in a chart or table in the full window, select the Maximize
icon in the top right of the area.

Hover the mouse pointer over any line or bar graph to display information for that graph.

Area

Description

Connections tab >
Active connections

Displays all users currently connected to the server, including:
User ID - the ID of the connected user.

Name — the name of the connected user.

Creation time — the date and time the connection was established.
Connection I D — the ID of the connection.

Client I P address - the IP address of the client that made the connection.

Connections tab >
Connection details

Select a User ID to display that user's specific connection details, including:
Statement being executed — the statement executed by the selected user.

L ast request time— the last time a request was executed on the server by the
selected user.

Request type - type of request executed by the selected user.

L ast command time-the last time a command was executed on the server by
the selected user.

Command type - type of command executed by the selected user.

I Q temporary storeusage (K B) — number of temporary store kilobytes used
during the connection.

IQ temporary work space usage (K B) — number of temporary workspace
kilobytes used during the connection.

Cursor count — number of open Sybase 1Q cursors on the connection.

Thread in use — number of threads in use by the selected user.
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Area Description

Connections tab > Displays the transaction ID, creation time, and state of transactions executed
Associated transac- | by the selected user.

tions

Connection Statistics | Displays a chart of the number of user, internode incoming, internode out-
tab > Active connec- | going, and other connections to the server.
tions

Connection Statistics | Displays the number of user, internode incoming, internode outgoing, and
tab > User connec- other connections and disconnections per minute.

tions/disconnections
per minute

See also
«  Viewing Multiplex Connections Statistics on page 47

Viewing Transaction Statistics
Display transaction statistics for the selected Sybase 1Q server.

1. In the Perspective Resources window, right-click the resource and select M onitor
Node.

2. In the left pane of the 1Q Node Level Monitor view, select Transactions.
3. Select the tab for the desired information.

Note: Click a column header to sort the data by that column.

To display the information in a chart or table in the full window, select the Maximize icon in
the top right of the area.

Hover the mouse pointer over any line or bar graph to display information for that graph.

Area Description

Transactions tab > | Displays all transactions that are currently on the server, and their version
Transactions & ver- | details.
sions
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Area Description

Transactions tab > | Transaction details include:
Transaction details Transaction | D —the unique identification number for the selected transaction.

Connection | D — the connection identification number for the selected trans-
action.

Statement being executed — the statement executed by the selected transac-
tion.

1Q main store spacecreated by transaction (K B) — the amount of main store
space created by the selected transaction.

1Q main store space dropped by transaction (KB) — the amount of main
store space dropped by the selected transaction.

1Q temporary store space created by transaction (K B)- the amount of
temporary store space created by the selected transaction.

1Q temporary store space dropped by transaction (KB) — the amount of
temporary store space created by the selected transaction.

Cursor count — number of open Sybase 1Q cursors on the transaction.
1Q threads— number of threads being used by the transaction.
1Q govern priority — numeric priority of the transaction in the queue.

Connection or cursor — identifies whether the transaction is a connection or a
cursor.

Connection or cursor createtime— date and time the connection or cursor
was created.

Transaction statis- | Displays a chart of the number of user, internode communication (identified on
tics tab > Active the chart as INC), and other transactions on the server.
transactions

Transaction statis- | Displays additional details on the transaction, including:

i > - . . . .
tics tab > Other sta Number of committed tr ansactions—total number of committed transactions

tistics
on the server.
Number of activeload statements—total number of active load statements on
the server.
Oldest activetransaction time (minutes) —elapsed time, in minutes, since the
oldest active transaction's creation.
See also

o Viewing Multiplex Transaction Statistics on page 48
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Viewing Dbspace Statistics
Display dbspace statistics for the selected Sybase 1Q server.

1. In the Perspective Resources window, right-click the resource and select M onitor
Node.

2. In the left pane of the IQ Node Level Monitor view, select DBSpaces.

Note: Click a column header to sort the data by that column.

To display the information in a chart or table in the full window, select the Maximize icon in
the top right of the area.

Hover the mouse pointer over any line or bar graph to display information for that graph.

Area Description

DBSpaces Displays the dbspaces on the server.

DBSpace details | Select a dbspace to display the details for the dbspace, including:
tab DBSpace size — total size of the dbspace, in kilobytes.

Sizein use— amount of space being used in the dbspace, in kilobytes.
Size available — percentage of the dbspace available for use.
Reserved size - reserved space for the dbspace.

Stripe size - size allowed for the stripe.

Number of files— number of files in the dbspace.

Number of RW files— number of read/write files in the dbspace.

Droppable - indicates whether the dbspace file can be dropped.

DBSpace size Displays the total size of the dbspace, as well as the percentages of the dbspace that
Details tab are in use and available.

DBSpace files Displays the list of DBSpace files that are part of the selected DBSpace.
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Area Description
DBSpace file de- | Select the a dbspace file to display details for the dbspace file, including:
tails tab File size — total size of the dbspace file, in kilobytes.
Sizein use — amount of space being used in the file, in kilobytes.
Size available — percentage of the file available for use.
Reserved size - reserved space for the dbspace file.
Stripe size - size allowed for the stripe.
Droppable - indicates whether the dbspace file can be dropped.
DBSpace file Displays the size of the selected dbspace file, as well as the percentages of the
size details tab | dbspace file that are in use and available.

Viewing Store I/0 Statistics
Display the store 1/O statistics for the selected Sybase 1Q server.

1. In the Perspective Resources window, right-click the resource and select M onitor
Node.

2. In the left pane of the 1Q Node Level Monitor view, select Store I/O.

Note: To display the information in a chart or table in the full window, select the Maximize
icon in the top right of the area.

Hover the mouse pointer over any line or bar graph to display information for that graph.

Area Description

Disk Reads | Number of disk reads per second on the catalog store, main store, and temporary store.

Disk Writes | Number of disk writes per second on the catalog store, main store, and temporary store.

Viewing Cache Statistics
Display the cache statistics for the selected Sybase 1Q server.

1. In the Perspective Resources window, right-click the resource and select Monitor
Node.

2. In the left pane of the IQ Node Level Monitor view, select Caches.
3. Select the tab for the desired information.

Note: Hover the mouse pointer over any line or bar graph to display information for that
graph.
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Tab Description
Cache Catalog cache — the megabyte allocation for the catalog cache, and the number of
size megabytes in use.

M ain cache- the megabyte allocation for the main cache, and the number of megabytes
in use.

Tempor ary cache— the megabyte allocation for the temporary cache, and the number of
megabytes in use.

Cache Number of cache reads per second for a period of time. The cache reads for the catalog,
reads main, and temporary caches appear.

Cache sta- | Displays the cache statistics for the catalog, main, and temporary caches. Each cache
tistics type includes statistics for:

Size (mb) — total size of the cache, in megabytes.
In use (%) — percentage of the cache being used.
Reads (per second) — number of cache reads per second.

Hits (per second) — number of hits, per second, to the the catalog, main, and temporary
caches.

Dirty pages(%) - percentage of pages in the catalog, main, and temporary caches where
data has been modified and stored in the buffer cache and has not yet been written to
disk.

Pinned — number of pinned catalog, main, and temporary cache pages.

Pinned (%) — percentage of the catalog, main, and temporary chaches pinned.

See also
o Viewing Multiplex Cache Statistics on page 49

Viewing Table Version Statistics
Display the table version statistics for the selected Sybase 1Q server.

1. In the Perspective Resources window, right-click the resource and select Monitor
Node.

2. In the left pane of the IQ Node Level Monitor view, select Table Versions.

Note: To display the information in a chart or table in the full window, select the Maximize
icon in the top right of the area.

Area Description
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Area

Description

Statis-
tics

Number of committed ver sions— the number of table versions in the server.

Total version space used (M B) — total space consumed by all the table versions.
Oldest version 1D — the oldest version identifier on the server.

Number of active versions— total number of active write table versions on the server.

Total active version space created (M B) — amount of data created by active write trans-
actions.

Total active version space to be destroyed (M B) — amount of data destroyed by active
write transactions. If these transactions commit, the destroyed data becomes an old version
and is eventually dropped. If the transactions roll back, the created data is released.

Table
versions

Version | D — the table version identifier.
Server name — the name of the server.
Connection ID — the connection ID using this table version.

MinK BRelease- the minimum amount of space returned once this version is no longer in
use.

M axK BRelease—the maximum amount of space returned once this version is no longer in
use.

WasReported — indicates whether the server has received usage information for this
version.

Viewing Operation and Request Statistics

Display the operation and request statistics for the selected Sybase 1Q server.

1. In the Perspective Resources window, right-click the resource and select M onitor

Node.

2. In the left pane of the IQ Node Level Monitor view, select Operations & Requests.

Note: To display the information in a chart or table in the full window, select the Maximize
icon in the top right of the area.

Hover the mouse pointer over any line or bar graph to display information for that graph.

Area

Description

Opera-
tions

Total operations— the total number of 1Q operations of any type.
Active operations — the number of active 1Q operations.

Waiting oper ations— the number of 1Q operations waiting for the resource governor.
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Area Description

Requests | Requests—the number of times per second the server has been accessed to handle a new
request or continue processing an existing request.

Active requests — the number of active requests.

Unscheduled requests— the number of requests that are currently in the queue, waiting
for an available server thread.

Viewing Network Statistics
Display the network statistics for the selected Sybase 1Q server.

1. In the Perspective Resources window, right-click the resource and select M onitor
Node.

2. In the left pane of the IQ Node Level Monitor view, select Network.
3. Select the tab for the desired information.

Note: To display the information in a chart or table in the full window, select the Maximize
icon in the top right of the area.

Hover the mouse pointer over any line or bar graph to display information for that graph.

Area Description

Network us- | Bytesreceived —amount of data, in bytes, received by the server.
age Bytes received uncompressed — amount of uncompressed data, in bytes, received
by the server.

Bytes sent — amount of data, in bytes, sent by the server.

Bytes sent uncompressed — amount of uncompressed data, in bytes, sent by the
server.

Free communication buffers— number of free communication buffers.

Total communication buffers— total number of communication buffers.

Data transfer | Displays the amount of data, in kilobytes, sent and received by the server over time.
history

Buffer usage | Shows the total number of communication buffers, and a graph displaying the num-
ber of used and free communication buffers.

Monitoring a Multiplex Server
Statistics let you monitor the availability and performance of a multiplex.

Sybase Control Center for Sybase 1Q 41



Manage and Monitor

See also

e Monitoring a Single Node on page 30

Viewing Multiplex Overview Statistics

Display the overall health of the Sybase 1Q multiplex environment.

1. In the Perspective Resources window, right-click the resource and select M onitor

Multiplex.

2. In the left pane of the IQ Multiplex Level Monitor view, select Overview.
3. Select the tab for the desired information.

Note: Click a column header to sort the data by that column.

To display the information in a chart or table in the full window, select the Maximize icon in
the top right of the area.

Hover the mouse pointer over any line or bar graph to display information for that graph.

Area

Description

Multiplex tab >
Servers

Server — name of the server.
Host — host name where the server is running.
Port — port number where the server is running.

State — current state of the server. Valid states include:

e Unknown
e Stopped
e Running

Role - role the server plays in the multiplex configuration. Roles include:

¢ Coordinator
e Reader
e Writer

Status— current status of the server in the multiplex. Valid states include:

¢ Included
¢ Excluded

Multiplex tab >
CPU history

Percentage of total CPU usage over a period of time for each server. The legend
below the chart identifies the colored line associated with each server.

Multiplex tab >

1Q memory

Allocation of the 1Q memory between the main cache and temporary cache for each
server in the multiplex.
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Area Description

Disk usage tab | Available and used space for the main and temporary stores on each server in the
multiplex.

Version usage | Number of committed versions - the number of table versions in the servers.
tab > Statistics . .
Total version space used (M B) — total space consumed by all the table versions.
Oldest version I D — the oldest table version identifier on the server.

Number of active versions — total number of active write table versions on the
Servers.

Total active version space created (M B) —amount of data created by active write
transactions.

Total active version space to be destroyed (M B) — amount of data destroyed by
active write transactions. If these transactions commit, the destroyed data becomes
an old version and is eventually dropped. If the transactions roll back, the created
data is released.

Version usage | Version |ID — the table version identifier.

> i . .
tab . Multiplex Server name - the name of the server where the table version exists.
version usage
Connection I D - the connection 1D using this table version.

WasReported — indicates whether the server has received usage information for
this table version.

MinK BRelease-the minimum amount of space returned once this table version is
no longer in use.

M axK BRelease—the maximum amount of space returned once this table version is
no longer in use.

See also
»  Viewing Overview Statistics on page 30

Viewing Multiplex Topology Statistics
Display the topology view of the Sybase 1Q multiplex.

The topology view represents the entire multiplex grid environment, which consists of nodes
and links. A node represents a multiplex server, while a link represents the connection
between two multiplex nodes. Only one coordinator node appears, and links exist only
between the coordinator node and a secondary node. There are no links between two
secondary nodes.
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In the Perspective Resources window, right-click the resource and select M onitor
Multiplex.
In the left pane of the 1Q Multiplex Level Monitor view, select Topology.

To modify the layout of the topology view, click View Controls.

Layout options include:

« Autofit — rearranges the nodes to ensure all nodes are visible.

e Zoom - increases or decreases the size of the view.

* Reset - restores the topology view to the default layout.

To view a list of the all nodes in the multiplex, and a list of the connections between the
coordinator node and its secondary nodes within the multiplex, click Details.

To monitor a single node within the multiplex, right-click the node in the topology view
and select Monitor Node.

When monitoring a single node from the topology screen, the 1Q Node Level Monitor is

displayed, and the node is registered as a single node resource and appears in the
Perspecive Resources view.

Displaying the Properties of a Multiplex Node

View the server information for a single node in the multiplex environment.

1

2.

In the Perspective Resources window, right-click the resource and select M onitor
Multiplex.

In the left pane of the 1Q Multiplex Level Monitor view, select Topology.

3. Right-click the node and select Properties.

The server properties dialog includes:

Server name — name of the server.

Host — host name where the server is running.

Port — port number where the server is running.
State — current state of the server. Valid states include:

e Unknown
« Stopped
* Running

INC state - state of the internode communication between the secondary node and the
coordinator. Valid values include:

» Active

e Timed out

N/A (not available)

e Unknown
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Note: When viewing the properties of the coordinator node, the INC state always displays
N/A.
* Role-role of the server within the multiplex. Valid roles include:
e Coordinator
e Writer
e Reader
* Status-— current status of the server. Valid states include:
e Included
e Excluded
¢ Database Path — location of the database file on the server.

Displaying Connection Properties
View the details of the connection between the coordinator node and secondary node.

1. In the Perspective Resources window, right-click the resource and select M onitor
Multiplex.

2. In the left pane of the IQ Multiplex Level Monitor view, select Topology.

3. Right-click the line between the coordinator node and the secondary node and select
Properties.

The internode communication properties dialog includes:

* Link —name of the linked coordinator node and secondary node.

* |NC state- state of the internode communication between the secondary node and the
coordinator. Valid values include:

* Active
e Timed out
* N/A (not available)
e Unknown
* Secondary server name— name of the secondary server.

» Heartbeat frequency —number of seconds between polls to ensure the secondary server is
connected.

e Last successful heartbeat — date and time the last successful heartbeat transmission was
received.

* Timenot responding — amount of time since the first failed heartbeat request.

¢ Timeuntil timeout — amount of time until the server connection times out and the
secondary node becomes inactive.

¢ Livenesstimeout — amount of time before the connection is terminated.

* Auto excludetimeout — amount of time before the secondary node is automatically
excluded.

* Max connection pool size— maximum number of connections to the server.
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* Current connection pool size— current number of connections to the server.
* Number of idle connections— number of connections to the server without any activity.
* Number of connectionsin use— number of active connections to the server.

Viewing Multiplex Server Statistics

Display the statistics for the servers in the Sybase 1Q multiplex.

1. In the Perspective Resources window, right-click the resource and select M onitor

Multiplex.

2. In the left pane of the IQ Multiplex Level Monitor view, select Servers.
3. Inthe Multiplex Servers area, select the server to display in the Server Details area.

Note: Click a column header to sort the data by that column.

To display the information in a chart or table in the full window, select the Maximize icon in
the top right of the area.

Tab

Description

Multiplex Servers

Server — name of the server.
Host — host name where the server is running.
Port — port number where the server is running.

State — current state of the server. Valid states include:

» Unknown
» Stopped
* Running

Role - role of the server within the multiplex. Valid roles include:

e Coordinator
e Writer
» Reader

Status— current status of the server. Valid states include:

* Included
» Excluded
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Tab

Description

Server Details

Server name — name of the server.

State — current state of the server. Valid states include:

* Unknown
» Stopped
* Running

Database — name of the 1Q database.

Server version — version of the 1Q server.

Platform — operating system running on the server's host.

Database path — location of the database file on the server.

Viewing Multiplex Connections Statistics

Display the connection statistics for all servers in a Sybase 1Q multiplex.

1. In the Perspective Resources window, right-click the resource and select M onitor

Multiplex.

2. In the left pane of the 1Q Multiplex Level Monitor view, select Connections.

3. Todisplay a list of connections in the Multiplex connections area, click the arrow beside
the desired server name.

4. On the Active Connections tab, click the bar chart for a server to display the active
connection details in a pie chart.

Note: To display the information in a chart or table in the full window, select the Maximize
icon in the top right of the area.

Hover the mouse pointer over any line or bar graph to display information for that graph.

Area

Description

Connections tab >
Multiplex connec-
tions

Displays all users currently connected to each server, including:

Server — the name of the server.
User ID - the ID of the connected user.
Connection I D - the ID of the connection.

Name — the name of the connected user.

Connection create time— the date and time the connection was established.

Client | P address - the IP address of the client that made the connection.

Sybase Control Center for Sybase 1Q
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Area

Description

minute

Connections tab > | Displays the number of user connections and disconnections per minute for
User connections/ | each server.

disconnections per

tab

Active connections | Displays a chart of the number of user, internode incoming, internode outgo-

ing, and other connections to the selected server.

See also

»  Viewing Connection Statistics on page 34

Viewing Multiplex Transaction Statistics

Display transaction statistics for all servers in a Sybase 1Q multiplex.

1. In the Perspective Resources window, right-click the resource and select Monitor

Multiplex.

2. In the left pane of the 1Q Multiplex Level Monitor view, select Transactions.
3. To display a list of transactions, click the arrow beside the desired server name.

4. On the Transaction Statistics tab, click the bar chart for a server to display the transaction
details in a pie chart.

Note: To display the information in a chart or table in the full window, select the Maximize
icon in the top right of the area.

Hover the mouse pointer over any line or bar graph to display information for that graph.

Area

Description

Transactions
tab > MPX
Transactions

Transaction I D — the unique identification number for the selected transaction.
Version | D — the version identification number for the selected transaction.
User I D —the user name of the user that started the selected transaction.
State— the current state of the selected transaction. Possible states include:

« Active- the transaction is being processed.
* Committed — the transaction has completed processing.

Creation time — the date and time when the selected transaction was created.

Transaction
statistics tab

Displays a chart of the number transactions for each server in the multiplex. Se-
lecting a server in the chart displays a pie chart of user and internode communica-
tions (identified on the chart as INC) transactions.
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See also
»  Viewing Transaction Statistics on page 35

Viewing Multiplex Cache Statistics
Display the cache statistics for all servers in a Sybase 1Q multiplex.

1. In the Perspective Resources window, right-click the resource and select M onitor
Multiplex.

2. In the left pane of the IQ Multiplex Level Monitor view, select Caches.
3. Select the tab for the cache type to show.

Each cache type tab provides a graph with colored lines for each selected server.

Note: To display the information in a chart or table in the full window, select the Maximize
icon in the top right of the area.

Hover the mouse pointer over any line or bar graph to display information for that graph.

Chart Description
Cache Number of cache reads per second for a period of time. The cache reads for the catalog,
reads main, and temporary caches appear. The legend at the right of the chart identifies the

colored line associated with each server.

Cache size | The megabyte allocation for the selected cache type on each server in the multiplex, and
the number of megabytes in use.

See also
»  Viewing Cache Statistics on page 38
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Troubleshoot Sybase Control Center for Sybase

1Q

Troubleshoot problems that occur in Sybase Control Center for Sybase 1Q.

Error Message is Displayed When Trying to Authenticate a
Multiplex Server

Problem: Itis possible to register a multiplex server multiple times, or register multiple servers
of the same multiplex set in Sybase Control Center, but only the first authenticated resource
allows you to successfully authenticate the login account for the resource. Any attempts to
authenticate an additional multiplex server resource of the same multiplex set generates an
error and is not successful.

Solution: In the Resource Explorer, remove all but one instance of the registered multiplex
resources.

Alternatively, take note of the resource name identified in the error message, and in the
Resource Explorer add that resource to the Perspective view.

See also
» Registering a Sybase 1Q Serveron page 4
» Authenticating a Login Account for a Monitored Resource on page 7

Authenticating a Chinese or Japanese Sybase 1Q Server Fails

Problem: When authenticating a Chinese or Japanese Sybase 1Q server, if the login name or
password contain Chinese or Japanese characters, the login fails.

Solution:

1. Inthe Perspective Resources window, right-click the Chinese or Japanese server and select
Properties.

2. Inthe Resource Properties window, select Connection.

3. Enter the Character set used on the Sybase 1Q server.

4. Click OK.
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Glossary: Sybase Control Center for Sybase 1Q

Glossary of Sybase Control Center terms related to Sybase 1Q.

» alert— amechanism for notifying administrators when a managed resource experiences a
status change, or when a performance metric passes a user-specified threshold.

« alertinstance— a copy of an alert type that has been configured to generate a particular
kind of alert for a specific managed resource.

» alert notification — an indication that an alert has fired. Alert notifications appear in the
Alert Monitor view. If e-mail notification is enabled, alert notifications are also delivered
to the specified e-mail address.

« alert storm — the result of issuing many redundant alerts associated with a common or
root occurrence. See also alert suppression.

« alert storm suppression — a Sybase Control Center feature that can be configured to
prevent alert storms by suppressing repeat alert notifications for a specified period of time.

« alert target — the destination for an alert notification and source of an alert response.

« alerttype— (1) A template that defines the resource type and the key performance
indicator associated with an alert instance. (2) The basis on which an alert fires: state or
threshold. Some alerts are triggered by the state of their key performance indicator (for
example, running or stopped), while other alerts are triggered when their KP1’s numerical
value passes a specified threshold.

* availability — indicates whether a resource is accessible and responsive.

* catalog store— the portion of each Sybase 1Q database that contains its metadata.
(Metadata describes the layout of the Sybase 1Q tables, columns, and indexes.) The catalog
store contains the SYSTEM dbspace and up to 12 additional other catalog dbspaces. The
default name for this file is <dbname>.db.

e chart trend period — the period, in minutes, over which data is displayed in historical
charts. Set the chart trend period on the Settings screen of the Sybase 1Q Monitoring View.
Contrast with screen refresh interval.

« collection repeat interval — the period, in seconds, between successive repititions of a
statistics collection job. The collection repeat interval determines how often new data on
historical monitoring screens is available to be refreshed. Set the collection repeat interval
in the scheduler. See also screen refresh interval.

» collection — a named, predefined set of key performance indicators for which values are
collected from monitored servers at the same time. Collections supply the performance
and availability data shown on Sybase Control Center screens and charts. Use the
scheduler to view a list of collections and to control which collections run, how often they
run, and the length of time for which they run.

* connection — a connection from a Sybase 1Q server to a database.

« database— acollection of tables that are related by primary and foreign keys. The tables
hold the information in the database. The tables and keys together define the structure of
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the database. 1Q databases are specially indexed to take advantage of the query speed of
Sybase 1Q.

dbspace— an additional database file that creates more space for data. A database can be
held in up to 13 separate files (an initial file and 12 dbspaces). Each table, together with its
indexes, must be contained in a single database file.

event — an activity in the system, such as a user logging in, a service starting or stopping,
or a condition changing. Use the alerts feature to detect and notify you about system
events.

heat chart — a graphical view of resource availability in the current perspective.

job — a task performed by the scheduler in Sybase Control Center.

key performanceindicator (KPI) — a single metric used to evaluate the status or
performance of amonitored resource. A KPI value can be a state (such as running, error, or
stopped) or a numerical value. KPIs are grouped into collections (and also, for some
product modules, into key performance areas, or KPAs). KPI values are collected by
scheduled collection jobs and appear on monitoring screens and in the statistics and heat
charts. Examples of KPIs are Server Availability and Number of Blocked Processes.
key performancearea (KPA) — a group of related key performance indicators.

main store— the 1Q main store is the portion of each Sybase 1Q database that contains
persistent database structures, such as backup metadata and rollback data for committed
transactions.

multiplex — a powerful feature in Sybase 1Q that provides application scalability through
a clustered server configuration. Sybase 1Q multiplex allows concurrent data loads and
queries via independent data processing nodes connected to a shared data source. Each
multiplex server has its own catalog store and 1Q temporary store and all the servers share a
common IQ store.

node— atopology object representing a server or other entity type, displayed visually in
the form of an icon.

per spective— a named tab in Sybase Control Center that displays information related to a
collection of managed resources (such as servers) and a set of views associated with those
resources. The views in a perspective are chosen by users of the perspective. You can create
as many perspectives as you need, and customize them to monitor and manage your
resources. Perspectives allow you to group resources ways that make sense in your
environment—for example by location, department, or project.

repository — a database that stores information related to managed resources, along with
user preference data, operational data, and performance statistics.

resource— a unique Sybase product component (such as a server) or a subcomponent.
SCC-enabled login account — a user account that has been granted privileges in Sybase
Control Center by mapping appropriate Sybase Control Center roles. (Roles are typically
mapped to a group to which the account belongs rather than to the account itself.) The user
account and group can be native to Sybase Control Center or created in the operating
system or the LDAP directory service to which Sybase Control Center authentication is
delegated. You must use an SCC-enabled account to log in to Sybase Control Center.
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» schedule— the definition of a task (such as the collection of a set of statistics) and the time
interval at which Sybase Control Center executes the task.

» screenrefreshinterval — the period in seconds between refreshes of screens in the Sybase
1Q component of Sybase Control Center. Refreshing a screen redraws it with the most
recentavailable data. Set the screen refresh interval on the Settings screen of the Sybase 1Q
Monitoring View. See also collection repeat interval.

* store— astore is one or more dbspaces that store persistent or temporary data for a special
purpose. See catalog store, main store, or temporary store.

» tableversion — the unit of versioning is the table. Table-level versioning structures
aggregate data for columns at the table level. With table-level versioning, Sybase 1Q can
control access to the data at the level where write operations occur, and where query results
are focused.

* temporary store— the IQ temporary store is the portion of each 1Q database that stores
temporary tables and temporary scratch space data structures.

* topology — a graphical representation of how the servers in a multiplex environment are
connected to each other. It is a network diagram that provides a visual map of the
availability of the Sybase 1Q server environment.

» transaction — a set of related SQL statements that are treated as a single unit of work. To
ensure consistency, if all the statements in the set cannot be executed, the changes made by
the query are rolled back. The tables queried during the transaction are locked until a
transaction is completed.

* transaction log— the IQ transaction log records changes to the database. The transaction
log includes version information, free space, and other information you can use to recover
from a system failure. By default, the transaction log is created in the same directory as the
catalog store. The default name for this dbfile is <dbname>.log.

» trend period — See chart trend period.

* view— awindow in a perspective that displays information about one or more managed
resources. Some views also let you interact with managed resources or with Sybase
Control Center itself. For example, the Perspective Resources view lists all the resources
managed by the current perspective. Other views allow you to configure alerts, view the
topology of a replication environment, and graph performance statistics.
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